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About This Guide

OL-24406-01

The purpose of this document is to provide detailed steps to install the Cisco Prime Network Analysis 
Module (NAM) on a Nexus 1010 appliance, and then configure the NAM. 

This document contains the following chapters: 

 • Chapter 1, “Overview”

 • Chapter 2, “Installing NAM Software on the Nexus 1010 Appliance”

 • Chapter 3, “Configuring ERSPAN for Traffic Visibility”

 • Chapter 4, “Configuring NetFlow for Traffic Visibility”

 • Chapter 5, “Configuring and Monitoring the Nexus Virtual Switch as a Managed Device”

 • Chapter 6, “Troubleshooting”

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.
v
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C H A P T E R 1

Overview

The Cisco Prime Network Analysis Module (NAM) for Nexus 1010 provides a virtualization technology 
that enables a Nexus 1010 appliance to host other services and applications. The NAM 5.1 software is 
one such application that can be hosted on a Nexus 1010 appliance. 

This chapter contains the following sections:

 • About the Nexus 1010 Virtual Services Appliance, page 1-1

 • Configuration Requirements, page 1-2

 • Licensing, page 1-2

About the Nexus 1010 Virtual Services Appliance
The Nexus 1010 appliance must have the following minimum resources available for use as a virtual 
blade:

 • 2G RAM

 • 53G disk space
1-1
Nexus 1010 5.1 Installation and Configuration Guide



Chapter 1      Overview
Configuration Requirements
Figure 1-1 shows a NAM deployment scenario using Cisco Nexus 1010.

Figure 1-1 Cisco Prime Network Analysis Module (NAM) for Nexus 1010 Deployment

Configuration Requirements
Before you begin the software installation, ensure that the devices have been physically installed and set 
up for the following: 

 • The Nexus 1010 appliance has network connectivity through an Ethernet interface and is accessible 
using the serial console.

 • The NAM 5.1 software image is available on the Nexus 1010 appliance.

 • The Nexus 1010 appliance has adequate resources available to run NAM 5.1.

Licensing
The NAM software requires you to install a product license in the form of a text file. An evaluation 
license allows you to use the software for up to 60 days, but you will be unable to log in to the NAM 
GUI after the evaluation license expires. When using an evaluation license, the NAM login window 
indicates how many days remain before the evaluation license expires. 
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Chapter 1      Overview
Licensing
Node-Locking Information
The Cisco NAM license is used for one Nexus 1010 appliance. When you obtain the license for the 
appliance, the license is valid only for the appliance with the PID and SN you provide when you obtain 
the license. 

You can get the PID of the appliance using the show inventory CLI command. 

vsm-nam1# show inventory
PID: N1K-674-K9 VID: 0 SN: KQEDKRON
vsm-nam1#

Obtaining a License
To obtain a NAM Virtual Service Blade (VSB) license, go to the following URL:

http://www.cisco.com/go/license

Follow the instructions on this page to obtain a NAM VSB license file. You will need the appliance PID 
and SN to obtain the license file. After you enter the PID and SN or the Product Authorization Key, a 
license file will be sent to you by e-mail. Store this license file on an available FTP server. Use the 
license install command to install the license after the NAM software installation completes. 

Installing a License
To install a license file, use the install license command. See the next section, Licensing Commands, 
and the Network Analysis Module Command Reference Guide for more information about the install 
license command. 

The following is an example of the install license command: 

license install ftp://joseph@computer.com/bin/licenses/NAM_VB_License.lic

In this example, the install license command fetches the license file, NAM_VB_License.lic, from the 
directory /bin/licenses of the host computer.com. 

Licensing Commands
This section describes NAM CLI commands used to install and manage the NAM VSB license. You can 
find more details about these commands in the Network Analysis Module Command Reference Guide: 

http://www.cisco.com/en/US/docs/net_mgmt/network_analysis_module_software/5.1/command/ 
reference/guide/nam51_cmdref.html

license install ftp://<username>@<host>/<path>/<licensefilename>

Use the license install command to install a license file. 

show license

Use the show license command to display license information for the evaluation license and 
permanent licenses. 

config upload ftp://<username>@<host>/<path> [configfilename] [licensefilename]
1-3
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Chapter 1      Overview
Licensing
Use the config upload command to upload the license file. The configfilename and licensefilename 
options are optional. 

config network ftp://<username>@<host>/<path>/<filename> <licensefilename>

Use the config network command to restore the license file.

Obtaining Licensing Information
This section describes how to obtain current licensing information for a Nexus 1010 appliance. You can 
obtain licensing information the following ways:

 • Clicking About in the NAM GUI; see About the NAM GUI, page 1-4

 • Checking the audit trail; see Audit Trail, page 1-4

 • Checking the system alert; see System Alert, page 1-4

 • Using the show tech command; see show tech Command, page 1-4

About the NAM GUI

When you click About in the upper right corner of the NAM GUI, a window displays the software and 
version installed and information about any license currently installed. If a permanent license is 
installed, the PID and SN of the Nexus 1010 appliance is also displayed. 

Audit Trail

The audit trail records any license management activities as well as any modifications to the 
configuration and other system information. To view the audit trail, click Admin > Diagnostics, then 
click Audit Trail in the Contents menu. 

System Alert

System Alerts record any alert generated by the NAM. There are system alert messages sent by the NAM 
as the days pass prior to the expiration of the Evaluation License. System alert messages are sent when 
there are 20, 15, 10, 5, 4, 3, 2, and 1 days remaining and again when the license expires. 

show tech Command

The show tech CLI command contains a license information section that displays information about the 
license type and license status. 

You can also view the output of the show tech command from the NAM GUI by clicking Admin > 
Diagnostics > Tech Support. To locate the license information, search for licenseinfo. 
1-4
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Installing NAM Software on the Nexus 1010 
Appliance

This chapter provides information about installing the NAM 5.1 software on a supported Nexus 1010 
appliance (N1K-C1010). 

Note If you ordered a Cisco Nexus 1010 with NAM, the NAM installation media may already be loaded on 
the appliance. The installation media consists of an ISO file in bootflash:/repository.  
 
If you have a Cisco Nexus 1010 without NAM software, and you want to add it, you will need to 
download it from Cisco.com to a local ftp or http server, and then install it using the command copy 
ftp://path/to/nam/nam.iso bootflash:/repository from the Nexus VSM CLI.

This chapter contains the following section:

 • Installing NAM Software on a Nexus 1010 Appliance, page 2-1

Installing NAM Software on a Nexus 1010 Appliance

Step 1 Log in to the Nexus 1010 and enter virtual blade configuration mode:

vsm-nam1# conf t

Step 2 List the contents of the repository.

vsm-nam1(config)# dir bootflash:/repository
  ... 
  153135104     Mar 20 09:37:17 2011     nam-5-1-1.iso
  ...

Usage for bootflash://sup-local
   305664000 bytes used
  3685715968 bytes free
  3991379968 bytes total
vsm-nam1(config)# 

Use the directory listing to enter the correct ISO file that contains the NAM media.

In the example above, “nam-5-1-1.iso” is the filename, and the user is using this command to find the 
nam install media (an iso file found in bootflash:/repository).

Step 3 Enter the virtual service blade creation mode.
2-1
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Chapter 2      Installing NAM Software on the Nexus 1010 Appliance
Installing NAM Software on a Nexus 1010 Appliance
vsm-nam1(config)# virtual-service-blade NAM
vsm-nam1(config-vb-config)#

Step 4 Enter the NAM configuration information.

Note The data VLAN is used for both management and data (packet) collection for the virtual NAM.  
Unlike the VSM, the virtual NAM does not inherit the management VLAN from the VSB. The 
IP address assigned to the NAM must be in the data VLAN.

vsm-nam1(config-vb-config)# virtual-service-blade-type new 
nam-5-1-1.iso
vsm-nam1(config-vb-config)# interface data vlan 3
vsm-nam1(config-vb-config)# enable
Enter vsb image:[nam-5-1-1.iso]
Enter Management IPV4 address:  172.20.122.107
Enter Management subnet mask:  255.255.255.128
IPv4  address of the default gateway: 172.20.122.1
Enter Hostname:  nam-vsm1
Setting Web user/passwd will enable port 80. Press Enter[y/n]:y
Web User name:  [admin]
Web User password:  admin
vsm-nam1(config-vb-config)#

Step 5 The NAM VSB installation will begin. You can use the show virtual-service-blade summary command 
to see the installation in progress.

vsm-nam1(config-vb-config)# show virtual-service-blade summary

Step 6 To view installation progress, log in to the NAM console. When the status says “POWER ON,” the 
installation is complete.

Note The default password is “root.”

vsm-nam1# login virtual-service-blade nam
Telnet escape character is '$'.
Trying 127.1.0.18...
Connected to 127.1.0.18.
Escape character is '$'.

Cisco Network Analysis Module

nam.cisco.com login: root
Password: 
Last login: Mar 20 15:18:47 2011 from dhcp-171-69-69-187.cisco.com on pts/2

Cisco Virtual Blade on Nexus Appliance (Nexus VB) (R200-1120402) Console, 5.1
Copyright (c) 1999-2011 by Cisco Systems, Inc.

root@nam.cisco.com#
2-2
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Configuring ERSPAN for Traffic Visibility

Encapsulated Remote Switched Port Analyzer (ERSPAN) records provide an aggregate view of the 
network traffic. When enabled on the branch router or switch, the ERSPAN data source becomes 
available on the Cisco NAM VSB. ERSPAN provides statistics for applications, hosts, and conversions. 
You can set up custom data sources for some specific interfaces. ERSPAN can be used to identify 
business critical applications hosted in the Data Center that are used in the branch.

This chapter contains the following sections:

 • About ERSPAN, page 3-1

 • Prerequisites for Configuring ERSPAN, page 3-3

 • Configuring ERSPAN on the Cisco Nexus 1000V, page 3-3

 • Configuring ERSPAN Data Source on the NAM VSB, page 3-4

About ERSPAN

ERSPAN Overview
ERSPAN sessions allow you to monitor traffic on one or more ports, or one or more VLANs, and send 
the monitored traffic to one or more destination ports. ERSPAN sends traffic to a network analyzer such 
as a SwitchProbe device or other Remote Monitoring (RMON) probe. ERSPAN supports source ports, 
source VLANs, and destination ports on different routers, which provides remote monitoring of multiple 
routers across your network (see Figure 3-1). 

ERSPAN consists of an ERSPAN source session, routable ERSPAN GRE-encapsulated traffic, and an 
ERSPAN destination session. You separately configure ERSPAN source sessions and destination 
sessions on different routers. 

An ERSPAN source session is defined by the following:

 • A session ID

 • A list of source ports or source VLANs to be monitored by the session

 • The destination and the origin IP addresses, which are used as the destination and source IP 
addresses of the GRE envelope for the captured traffic, respectively

 • An ERSPAN flow ID

 • Optional attributes related to the GRE envelope such as IP TOS and TTL.
3-1
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About ERSPAN
For a source port or a source VLAN, the ERSPAN can monitor ingress, egress, or both ingress and egress 
traffic. 

ERSPAN source sessions do not copy ERSPAN GRE-encapsulated traffic from source ports. Each 
ERSPAN source session can have either ports or VLANs as sources, but not both.

The ERSPAN source sessions copies traffic from the source ports or source VLANs and forwards the 
traffic using routable GRE-encapsulated packets to the ERSPAN destination session. The ERSPAN 
destination session switches the traffic to the destination ports.

Figure 3-1 ERSPAN Configuration

Monitored Traffic
These sections describe the traffic that ERSPAN can monitor:

 • Monitored Traffic Direction, page 3-2

 • Monitored Traffic, page 3-2

Monitored Traffic Direction

For a source port or a source VLAN, the ERSPAN can monitor ingress, egress, or both ingress and egress 
traffic.

Monitored Traffic 

By default, ERSPAN monitors all traffic, including multicast and bridge protocol data unit (BPDU) 
frames.
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Chapter 3      Configuring ERSPAN for Traffic Visibility
Prerequisites for Configuring ERSPAN
ERSPAN Sources
These sections describe ERSPAN sources:

 • Source Ports, page 3-3

 • Source VLANs, page 3-3

Source Ports 

A source port is a port monitored for traffic analysis. You can configure source ports in any VLAN, and 
trunk ports can be configured as source ports and mixed with nontrunk source ports. 

Source VLANs 

A source VLAN is a VLAN monitored for traffic analysis. 

ERSPAN Destination Ports
A destination port is a Layer 2 or Layer 3 LAN port to which ERSPAN sends traffic for analysis. 

When you configure a port as a destination port, it can no longer receive any traffic. When you configure 
a port as a destination port, the port is dedicated for use only by the ERSPAN feature. An ERSPAN 
destination port does not forward any traffic except that required for the ERSPAN session. You can 
configure trunk ports as destination ports, which allows destination trunk ports to transmit encapsulated 
traffic.

Prerequisites for Configuring ERSPAN
ERSPAN can be configured after you have installed the Nexus 1000V software on the Nexus 1010.

You can configure ERSPAN source sessions, destination sessions, or both. A device that has only 
ERSPAN source sessions configured is called ERSPAN source device, and a device that has only 
ERSPAN destination sessions configured is called ERSPAN termination device. 

Configuring ERSPAN on the Cisco Nexus 1000V
Configure ERSPAN traffic on the Branch edge router. You must enable ERSPAN on both the WAN and 
LAN interface to provide visibility into traffic flows entering and leaving the branch. 

Refer to “Configuring Local SPAN and ERSPAN” in the Cisco Nexus 1000V System Management 
Configuration Guide, Release 4.2(1) SV1(4):

http://www.cisco.com/en/US/docs/switches/datacenter/nexus1000/sw/4_2_1_s_v_1_4/system_ma
nagement/configuration/guide/n1000v_system_9span.html

This chapter describes how to configure the local and encapsulated remote (ER) switched port analyzer 
(SPAN) feature to monitor traffic and includes the following topics: 

 • Information About SPAN and ERSPAN 

 • SPAN Guidelines and Limitations 
3-3
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Configuring ERSPAN Data Source on the NAM VSB
 • Default Settings 

 • Configuring SPAN 

 • Verifying the SPAN Configuration 

 • Example Configurations 

 • Additional References 

Configuring ERSPAN Data Source on the NAM VSB
After you have configured ERSPAN on the Nexus 1000V, use the Network Analysis Module (NAM) to 
enable additional ERSPAN monitoring devices.

See the following sections about using ERSPAN as a data source:

 • Enabling Autocreation of ERSPAN Data Sources Using the Web GUI, page 3-4

 • Enabling Autocreation of ERSPAN Data Sources Using the CLI, page 3-5

 • Disabling Autocreation of ERSPAN Data Sources Using the Web GUI, page 3-5

 • Disabling Autocreation of ERSPAN Data Sources Using the CLI, page 3-5

 • Creating ERSPAN Data Sources Using the Web GUI, page 3-5

 • Creating ERSPAN Data Sources Using the CLI, page 3-6

 • Deleting ERSPAN Data Sources Using the Web GUI, page 3-8

 • Deleting ERSPAN Data Sources Using the CLI, page 3-8

 • Configuring ERSPAN on Devices, page 3-9

Enabling Autocreation of ERSPAN Data Sources Using the Web GUI

There is a convenient “autocreate” feature for data sources, which is enabled by default. With the 
autocreate feature, a new data source will automatically be created for each device that sends ERSPAN 
traffic to the NAM, after the first packet is received. Manual creation of ERSPAN data sources using the 
NAM GUI or the CLI is typically not necessary. When manually creating a data source, you may specify 
any name you want for the data source. A data source entry must exist on the NAM in order for it to 
accept ERSPAN packets from an external device. 

Autocreated ERSPAN data sources will be assigned a name in the format ERSPAN-<IP 
Address>-ID-<Integer>, where IP Address is the IP address of the sending device, and Integer is the 
Session-ID of the ERSPAN session on that device. For example, device 192.168.0.1 sending ERSPAN 
packets with the Session ID field set to 12 would be named “ERSPAN-192.168.0.1-ID-12.” You can edit 
these autocreated data sources and change the name if desired.

One device can be configured to send multiple separate ERSPAN sessions to the same NAM. Each 
session will have a unique Session ID. The NAM can either group all sessions from the same device into 
one data source, or have a different data source for each Session ID. When data sources are autocreated, 
they will be associated with one particular Session ID. When manually created, you can instruct the 
NAM to group all traffic from the same device into one data source. If you check the Session check box, 
and enter a Session ID in the Value field, the data source will only apply to that specific session. If you 
leave the check box unchecked, all ERSPAN traffic from the device will be grouped together into this 
data source, regardless of Session ID.
3-4
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Chapter 3      Configuring ERSPAN for Traffic Visibility
Configuring ERSPAN Data Source on the NAM VSB
To configure the NAM to automatically create data sources when it receives ERSPAN packets from an 
external device, use the following steps. Remember however, that the autocreate feature is turned on by 
default, so these steps are typically not necessary.

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click the Auto Create button on the bottom left of the window.

Step 3 Check the ERSPAN check box to toggle autocreation of ERSPAN data sources to “on”.

Step 4 Click the Submit button.

Enabling Autocreation of ERSPAN Data Sources Using the CLI

Configuration of the autocreate feature is also possible using the NAM CLI. Because the autocreate 
feature is turned on by default, in most cases these steps are not necessary.

To configure the NAM to automatically create data sources when it receives ERSPAN packets from an 
external device, use the "autocreate-data-source" command as follows:

root@172-20-104-107.cisco.com# autocreate-data-source erspan

ERSPAN data source autocreate successfully ENABLED

The NAM will now automatically create a ERSPAN data source for each device that sends ERSPAN 
packets to it.  The data source will have the specific Session ID that is populated by the device in the 
ERSPAN packets sent to the NAM.  If the same device happens to send ERSPAN packets to the NAM 
with different Session ID values, a separate data source will be created for each unique Session ID sent 
from the device.

Disabling Autocreation of ERSPAN Data Sources Using the Web GUI

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click the Auto Create button on the bottom left of the window.

Step 3 Uncheck the ERSPAN check box to toggle autocreation of ERSPAN data sources to “off”.

Step 4 Click the Submit button.

Disabling Autocreation of ERSPAN Data Sources Using the CLI

To disable autocreation of ERSPAN data sources, use the no autocreate-data-source command as 
follows:

root@172-20-104-107.cisco.com# no autocreate-data-source erspan
ERSPAN data source autocreate successfully DISABLED
root@172-20-104-107.cisco.com#

Creating ERSPAN Data Sources Using the Web GUI

To manually configure a ERSPAN data source on the NAM using the GUI, for example if the 
autocreation feature is turned off, use the following steps:
3-5
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Configuring ERSPAN Data Source on the NAM VSB
Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click the Create button along the bottom of the window.

Step 3 From the Type drop-down list, choose “ERSPAN”.

Step 4 Enter the IP address of the device that will export ERSPAN to the NAM.

Step 5 Give the Data Source a name. This name will appear anywhere there is a Data Source drop-down list.

Step 6 (Optional) Check the Session check box and enter an Session ID into the Value field if the data source 
should only apply to that specific session. If you leave the check box unchecked, all ERSPAN traffic 
from the device will be grouped together into this data source, regardless of Session ID. 

Devices can be configured with multiple ERSPAN Sessions.   The packets exported may have the same 
source IP address, but the Session ID exported will be a different for each session. If you want to include 
only one Session in the data source, you must check the “Session” box and provide the value of that 
Session ID.

Step 7 Click the Submit button.

Creating ERSPAN Data Sources Using the CLI

To manually configure a ERSPAN data source on the NAM using the CLI (for example if the 
autocreation feature is turned off), use the following steps. Note that when using the CLI, there are two 
separate phases involved: First, you must create a “device” entry on the NAM and remember the device 
ID, and then you must create a data source entry using this device ID. In the NAM GUI, these two phases 
for creating ERSPAN data sources are combined together.

Step 1 Enter the command device erspan. You will now be in erspan device subcommand mode as shown here:

root@172-20-104-107.cisco.com# device erspan

Entering into subcommand mode for this command.
Type 'exit' to apply changes and come out of this mode.
Type 'cancel' to discard changes and come out of this mode.

root@172-20-104-107.cisco.com(sub-device-erspan)#

Step 2 Enter ? to see all the command options available, as in the example below:

root@172-20-104-107.cisco.com(sub-device-netflow)# ?
?                         - display help
address                   - device IP address (*)
cancel                    - discard changes and exit from subcommand mode
exit                      - create device and exit from sub-command mode
help                      - display help
show                      - show current config that will be applied on exit

(*) - denotes a mandatory field for this configuration.

root@172-20-104-107.cisco.com(sub-device-netflow)#

Step 3 Enter the IP address of the device as shown in this example (required):

root@172-20-104-107.cisco.com(sub-device-erspan)# address 192.168.0.1

Step 4 Type show to look at the device configuration that will be applied and verify that it is correct:

root@172-20-104-107.cisco.com(sub-device-erspan)# show
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DEVICE TYPE         : ERSPAN (Encapsulated Remote SPAN)
DEVICE ADDRESS      : 192.168.0.1

root@172-20-104-107.cisco.com(sub-device-erspan)#

Step 5 Type exit to come out of the subcommand mode and create the device. Remember the ID value that was 
assigned to the new device (you will need it to create the data source).

root@172-20-104-107.cisco.com(sub-device-erspan)# exit
Device created successfully, ID = 1
root@172-20-104-107.cisco.com#

Step 6 Enter the command data-source erspan. You will now be in erspan data source subcommand mode as 
shown here:

root@172-20-104-107.cisco.com# data-source erspan

Entering into subcommand mode for this command.
Type 'exit' to apply changes and come out of this mode.
Type 'cancel' to discard changes and come out of this mode.

root@172-20-104-107.cisco.com(sub-data-source-erspan)#

Step 7 Enter ? to see all the command options available, as in the example below:

root@172-20-104-107.cisco.com(sub-data-source-erspan)# ?
?                         - display help
cancel                    - discard changes and exit from subcommand mode
device-id                 - erspan device ID (*)
exit                      - create data-source and exit from sub-command mode
help                      - display help
name                      - data-source name (*)
session-id                - erspan Session ID
show                      - show current config that will be applied on exit

(*) - denotes a mandatory field for this configuration.

root@172-20-104-107.cisco.com(sub-data-source-erspan)#

Step 8 Enter the device ID from Step 4.

root@172-20-104-107.cisco.com(sub-data-source-erspan)# device-id 1

Step 9 Enter the name you would like for the data source (required):

root@172-20-104-107.cisco.com(sub-data-source-erspan)# name MyFirstErspanDataSource

Step 10 If desired, supply the specific Session ID for this ERSPAN data source (optional):

root@172-20-104-107.cisco.com(sub-data-source-erspan)# session-id 123

Step 11 Enter show to look at the data source configuration that will be applied and verify that it is correct:

root@172-20-104-107.cisco.com(sub-data-source-netflow)# show

DATA SOURCE NAME : MyFirstErspanDataSource
DATA SOURCE TYPE : ERSPAN (Encapsulated Remote SPAN)
DEVICE ID        : 1
DEVICE ADDRESS   : 192.168.0.1
SESSION ID       : 123

root@172-20-104-107.cisco.com(sub-data-source-erspan)#

Step 12 Enter exit to come out of the subcommand mode and create the data source:
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root@172-20-104-107.cisco.com(sub-data-source-erspan)# exit
Data source created successfully, ID = 3

The data source is now created, and ERSPAN records from the device will be received and accepted by 
the NAM as they arrive.

Deleting ERSPAN Data Sources Using the Web GUI

To delete an existing ERSPAN data source, use the following steps. Note that if the autocreation feature 
is turned on, and the device continues to send ERSPAN packets to the NAM, the data source will be 
recreated again automatically as soon as the next ERSPAN packet arrives. Therefore, if you wish to 
delete an existing ERSPAN data source, it is usually advisable to first turn the ERSPAN autocreate 
feature off, as described earlier.

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Choose the data source you would like to delete.

Step 3 Click the Delete button along the bottom of the window.

Deleting ERSPAN Data Sources Using the CLI

To delete a ERSPAN data source using the CLI, use the following steps. Note that when using the CLI, 
there are generally two separate phases involved. First you should delete the data source, then delete the 
device if you have no other data sources using the same device (for example with a different Engine ID 
value). As a shortcut, if you simply delete the device, then all data sources using that device will also be 
deleted.

Step 1 Show all data sources so you can find the ID of the one you want to delete:

root@172-20-104-107.cisco.com# show data-source

DATA SOURCE ID   : 1
DATA SOURCE NAME : DATA PORT 1
TYPE             : Data Port
PORT NUMBER      : 1
-----------

DATA SOURCE ID   : 2
DATA SOURCE NAME : DATA PORT 2
TYPE             : Data Port
PORT NUMBER      : 2
-----------

DATA SOURCE ID   : 3
DATA SOURCE NAME : MyFirstErspanDataSource
TYPE             : ERSPAN (Encapsulated Remote SPAN)
DEVICE ID        : 2
DEVICE ADDRESS   : 192.168.0.1
ENGINE ID        : 123
-----------

root@172-20-104-107.cisco.com#

Step 2 Use the no data-source command to delete the data source:
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root@172-20-104-107.cisco.com# no data-source 3
Successfully deleted data source 3
root@172-20-104-107.cisco.com#

Step 3 Show all devices so you can find the ID of the one you want to delete:

root@172-20-104-107.cisco.com# show device 

DEVICE ID            : 1
DEVICE TYPE          : ERSPAN (Encapsulated Remote SPAN)
IP ADDRESS           : 192.168.0.1
INFORMATION          : No packets received
STATUS               : Inactive
------

root@172-20-104-107.cisco.com#

Step 4 Use the no device command to delete the device:

root@172-20-104-107.cisco.com# no device 1
Sucessfully deleted device 1
root@172-20-104-107.cisco.com#

Note that if the autocreation mode is on, and the device continues to send ERSPAN packets to the NAM, 
the data source (and device entry) will be recreated again automatically as soon as the next ERSPAN 
packet arrives. Therefore, if you wish to delete an existing ERSPAN data source, it is usually advisable 
to first turn the ERSPAN autocreate feature off, as described earlier.

Configuring ERSPAN on Devices

There is only one way to configure ERSPAN so that the NAM receives the data: 

 • Sending ERSPAN Data Directly to the NAM Management Interface, page 3-9

Sending ERSPAN Data Directly to the NAM Management Interface

To send the data directly to the NAM management IP address (management-port), configure the 
ERSPAN source session. No ERSPAN destination session configuration is required. After performing 
this configuration on the Catalyst 6500 switch or Cisco 7600 series router, when ERSPAN packets are 
sent to the NAM, it will automatically create a data source for that packet stream. If the autocreate 
feature is not enabled, you will have to manually create the data source for this ERSPAN stream of traffic 
(see Creating ERSPAN Data Sources Using the Web GUI, page 3-5).

Note This method causes the ERSPAN traffic to arrive on the NAM management port. If the traffic level is 
high, this could have negative impact on the NAM’s performance and IP connectivity.

Sample Configuration
monitor session 1 type erspan-source
no shut
source interface Fa3/47

destination
erspan-id  Y 
ip address aa.bb.cc.dd
origin ip address ee.ff.gg.hh

Where: 
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 • Interface fa3/47 is a local interface on the erspan-source switch to be monitored

 • Y is any valid span session number

 • aa.bb.cc.dd is the management IP address of the NAM

 • ee.ff.gg.hh is the source IP address of the ERSPAN traffic
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Configuring NetFlow for Traffic Visibility

NetFlow records provide an aggregate view of the network traffic. When enabled on the branch router 
or switch, the NetFlow data source becomes available on the Cisco NAM. NetFlow provides statistics 
for applications, hosts, and conversations. You can set up custom data sources for some specific 
interfaces. NetFlow can be used to identify business critical applications hosted in the Data Center that 
are used in the branch.

As a consumer, the NAM can receive NetFlow packets on its management port from devices such as 
Cisco routers and switches. Those records are stored in its collection database as if that traffic had 
appeared on one of the NAM data ports. The NAM understands NetFlow v1, v5, v6, v7, v8, and v9.

This chapter contains the following sections:

 • Configuring NetFlow on Cisco IOS Routers

 • Configuring NetFlow Data Source on the NAM for Nexus 1010, page 4-2

Configuring NetFlow on Cisco IOS Routers
Configure NetFlow traffic on the Branch edge router. You must enable NetFlow on both the WAN and 
LAN interface to provide visibility into traffic flows entering and leaving the branch. 

config t

interface <interface>

ip route-cache flow

exit

ip flow-export version 5

ip flow-export destination <NAM-Ip-Address> 3000

Note The UDP port number must be set to 3000. 

Also make sure the SNMP Read Only community string is configured on the device.

snmp-server community <RO-string> RO
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Configuring NetFlow Data Source on the NAM for Nexus 1010
Use the NAM to enable additional NetFlow monitoring devices. 

Enabling Autocreation of NetFlow Data Sources Using the Web GUI
To configure the NAM to automatically create data sources when it receives NDE packets from an 
external device, use the following steps. Remember however, that the autocreate feature is turned on by 
default, so these steps are typically not necessary. 

Note In NAM 4.x releases, this was referred to as “Listening Mode.”

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click the Auto Create button on the bottom left of the window.

Step 3 Check the Netflow check box to toggle autocreation of NDE data sources on.

Step 4 Click the Submit button.

Enabling Autocreation of NetFlow Data Sources Using the CLI
Configuration of the autocreate feature is also possible using the NAM CLI. Remember that the 
autocreate feature is turned ON by default, so in most cases these steps are not necessary.

To configure the NAM to automatically create data sources when it receives NDE packets from an 
external device, use the following steps:

Use the autocreate-data-source command as follows:

root@172-20-104-107.cisco.com# autocreate-data-source netflow
NDE data source autocreate successfully ENABLED

The NAM will now automatically create a NetFlow data source for each device that sends NetFlow 
packets to it. The data source will have the specific Engine ID that is populated by the device in the NDE 
packets sent to the NAM. If the same device happens to send NDE packets to the NAM with different 
Engine ID values, a separate data source will be created for each unique Engine ID sent from the device.

Disabling Autocreation of NetFlow Data Sources Using the Web GUI

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click the Auto Create button on the bottom left of the window.

Step 3 Uncheck the Netflow check box to toggle autocreation of NDE data sources off.

Step 4 Click the Submit button.
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Disabling Autocreation of NetFlow Data Sources Using the CLI
To disable autocreation of NetFlow data sources, use the no autocreate-data-source command as 
follows:

root@172-20-104-107.cisco.com# no autocreate-data-source netflow
NDE data source autocreate successfully DISABLED
root@172-20-104-107.cisco.com#

Creating NetFlow Data Sources Using the Web GUI
To manually configure a NetFlow data source on the NAM using the GUI, for example if the autocreation 
feature is turned OFF, use the following steps:

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click the Create button along the bottom of the window.

Step 3 From the Type drop-down list, choose “NetFlow.”

Step 4 Enter the IP address of the device that will export NDE to the NAM (required).

Step 5 Give the Data Source a name. This name will appear anywhere there is a Data Source drop-down list.

Step 6 (Optional) If you know the specific value of the Engine ID on the device you would like to monitor, 
check the Engine check box, and enter the value of the Engine ID. If the Engine check box is left 
unchecked, then all NDE records exported by the device will be grouped into the same data source, 
regardless of the Engine ID populated in the NDE packets (in most cases the Engine check box can be 
left blank and you don't have to worry about the Engine ID value). 

Some devices have multiple Engines which independently export NDE records. For example, on some 
Cisco routers, NDE records can be exported by the Supervisor module as well as individual line cards. 
The packets exported may have the same source IP address, but the Engine ID exported by the Supervisor 
will be a different value than the Engine ID(s) exported by the line card(s). If you want to include only 
one Engine in the data source, you must check the “Engine” box and provide the value of that Engine ID.

Step 7 (Optional) SNMP v1/v2c RO Community String: If SNMP v1 or v2c will be used to communicate with 
the device, enter the community string that is configured on the device that is going to export NetFlow 
packets to the NAM. 

Step 8 (Optional) “Enable SNMP v3”: If SNMP v3 will be used to communicate with the device, fill in the 
fields within the v3-specific dialog.

Step 9 (Optional) If desired, fill in the SNMP credentials for the device. If valid SNMP credentials are provided, 
the NAM can upload readable text strings from the device to describe the interfaces on that device rather 
than just displaying the interfaces as numbers. You may specify either SNMPv2c or SNMPv3 
credentials. See Table 4-1, SNMP Credentials.

Table 4-1 SNMP Credentials 

Field Description

Mode: No Auth, No Priv SNMP will be used in a mode with no authentication and no 
privacy.

Mode: Auth, No Priv SNMP will be used in a mode with authentication, but no 
privacy.
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Step 10 Click the Submit button.

Creating NetFlow Data Sources Using the CLI
To manually configure a NetFlow data source on the NAM using the CLI, for example if the autocreation 
feature is turned off, use the following steps. Note that when using the CLI, there are two separate phases 
involved. First you must create a “device” entry on the NAM and remember the device ID. Then you 
must create a data source entry using this device ID. For convenience, these two phases are combined 
together when using the GUI to create NetFlow data sources.

Step 1 Enter the command device netflow. You will now be in netflow device subcommand mode as shown 
here:

root@172-20-104-107.cisco.com# device netflow

Entering into subcommand mode for this command.
Type 'exit' to apply changes and come out of this mode.
Type 'cancel' to discard changes and come out of this mode.

root@172-20-104-107.cisco.com(sub-device-netflow)#

Step 2 Enter ? to see all the command options available, as in the example below:

root@172-20-104-107.cisco.com(sub-device-netflow)# ?
?                         - display help
address                   - device IP address (*)
cancel                    - discard changes and exit from subcommand mode
community                 - SNMPv2c community string
exit                      - create device and exit from sub-command mode
help                      - display help
show                      - show current config that will be applied on exit
snmp-version              - SNMP version to use to communicate with device
v3-auth-passphrase        - SNMPv3 authentication passphrase
v3-auth-protocol          - SNMPv3 authentication protocol

Mode: Auth and Priv SNMP will be used in a mode with both authentication and 
privacy.

User Name Enter a username, which will match the username 
configured on the device.

Auth Password Enter the authentication password associated with the 
username that was configured on the device. Verify the 
password.

Auth Algorithm Choose the authentication standard which is configured on 
the device (MD5 or SHA-1). 

Privacy Password Enter the privacy password, which is configured on the 
device. Verify the password.

Privacy Algorithm Enter the privacy algorithm, which is configured on the 
device (AES or DES).

Table 4-1 SNMP Credentials (continued)

Field Description
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v3-priv-passphrase        - SNMPv3 privacy passphrase
v3-priv-protocol          - SNMPv3 privacy protocol
v3-sec-level              - SNMPv3 security level
v3-username               - SNMPv3 username

(*) - denotes a mandatory field for this configuration.

root@172-20-104-107.cisco.com(sub-device-netflow)#

Step 3 Enter the IP address of the device as shown in this example (required):

root@172-20-104-107.cisco.com(sub-device-netflow)# address 192.168.0.1

Step 4 If desired, enter the SNMP credentials for the device, as in the example below.  If you specify 
snmp-version v2c, then you should enter the community string for the device.  If you specify 
snmp-version v3, then you should enter the security level, username, authentication protocol, 
authentication passphrase, privacy protocol, and privacy passphrase.

root@172-20-104-107.cisco.com(sub-device-netflow)# snmp-version v2c
root@172-20-104-107.cisco.com(sub-device-netflow)# community public

Step 5 Type show to look at the device configuration that will be applied and verify that it is correct:

root@172-20-104-107.cisco.com(sub-device-netflow)# show

DEVICE TYPE         : NDE (Netflow Data Export)
DEVICE ADDRESS      : 192.168.0.1
SNMP VERSION        : SNMPv2c
V2C COMMUNITY       : public
V3 USERNAME         : 
V3 SECURITY LEVEL   : No authentication, no privacy
V3 AUTHENTICATION   : MD5
V3 AUTH PASSPHRASE  : 
V3 PRIVACY          : DES
V3 PRIV PASSPHRASE  : 

root@172-20-104-107.cisco.com(sub-device-netflow)#

Step 6 Enter exit to come out of the subcommand mode and create the device. Remember the ID value that was 
assigned to the new device, you will need it to create the data source!

root@172-20-104-107.cisco.com(sub-device-netflow)# exit
Device created successfully, ID = 1
root@172-20-104-107.cisco.com#

Step 7 Enter the command data-source netflow. You will now be in netflow data source subcommand mode as 
shown here:

root@172-20-104-107.cisco.com# data-source netflow

Entering into subcommand mode for this command.
Type 'exit' to apply changes and come out of this mode.
Type 'cancel' to discard changes and come out of this mode.

root@172-20-104-107.cisco.com(sub-data-source-netflow)#

Step 8 Enter ? to see all the command options available, as in the example below:

root@172-20-104-107.cisco.com(sub-data-source-netflow)# ?
?                         - display help
cancel                    - discard changes and exit from subcommand mode
device-id                 - netflow device ID (*)
engine-id                 - netflow Engine ID
exit                      - create data-source and exit from sub-command mode
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help                      - display help
name                      - data-source name (*)
show                      - show current config that will be applied on exit

(*) - denotes a mandatory field for this configuration.

root@172-20-104-107.cisco.com(sub-data-source-netflow)#

Step 9 Enter the device ID from Step 4 (required):

root@172-20-104-107.cisco.com(sub-data-source-netflow)# device-id 1

Step 10 Enter the name you would like for the data source (required):

root@172-20-104-107.cisco.com(sub-data-source-netflow)# name MyFirstNdeDataSource

Step 11 If desired, supply the specific Engine ID for this NDE data source (optional):

root@172-20-104-107.cisco.com(sub-data-source-netflow)# engine-id 123

Step 12 Enter show to look at the data source configuration that will be applied and verify that it is correct:

root@172-20-104-107.cisco.com(sub-data-source-netflow)# show

DATA SOURCE NAME : MyFirstNdeDataSource
DATA SOURCE TYPE : NDE (Netflow Data Export)
DEVICE ID        : 1
DEVICE ADDRESS   : 192.168.0.1
ENGINE ID        : 123

root@172-20-104-107.cisco.com(sub-data-source-netflow)#

Step 13 Enter exit to come out of the subcommand mode and create the data source:

root@172-20-104-107.cisco.com(sub-data-source-netflow)# exit
Data source created successfully, ID = 3

The data source is now created, and NDE records from the device will be received and accepted by the 
NAM as they arrive.

Deleting NetFlow Data Sources Using the Web GUI
To delete an existing NetFlow data source, use the following steps.  Note that if the autocreation feature 
is turned on, and the device continues to send NDE packets to the NAM, the data source will be recreated 
again automatically as soon as the next NDE packet arrives.  Therefore, if you wish to delete an existing 
NetFlow data source, it is usually advisable to first turn the NetFlow autocreate feature off, as described 
earlier.

Step 1 Choose Setup > Traffic > NAM Data Sources.

Step 2 Click on the data source you would like to delete.

Step 3 Click the Delete button along the bottom of the window.
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Deleting NetFlow Data Sources Using the CLI
To delete a NetFlow data source using the CLI, use the following steps.  Note that when using the CLI, 
there are generally two separate phases involved.  First you should delete the data source, then delete the 
device if you have no other data sources using the same device (for example with a different Engine ID 
value).  As a shortcut, if you simply delete the device, then all data sources using that device will also 
be deleted.

Step 1 Show all data sources so you can find the ID of the one you want to delete:

root@172-20-104-107.cisco.com# show data-source

DATA SOURCE ID   : 1
DATA SOURCE NAME : DATA PORT 1
TYPE             : Data Port
PORT NUMBER      : 1
-----------

DATA SOURCE ID   : 2
DATA SOURCE NAME : DATA PORT 2
TYPE             : Data Port
PORT NUMBER      : 2
-----------

DATA SOURCE ID   : 3
DATA SOURCE NAME : MyFirstNdeDataSource
TYPE             : NDE (Netflow Data Export)
DEVICE ID        : 2
DEVICE ADDRESS   : 192.168.0.1
ENGINE ID        : 123
-----------

root@172-20-104-107.cisco.com#

Step 2 Use the no data-source command to delete the data source:

root@172-20-104-107.cisco.com# no data-source 3
Successfully deleted data source 3
root@172-20-104-107.cisco.com#

Step 3 Show all devices so you can find the ID of the one you want to delete:

root@172-20-104-107.cisco.com# show device 

DEVICE ID            : 1
DEVICE TYPE          : NDE (Netflow Data Export)
IP ADDRESS           : 192.168.0.1
SNMP VERSION         : SNMPv2c
V2C COMMUNITY        : public
V3 USERNAME          : 
V3 SECURITY LEVEL    : No authentication, no privacy
V3 AUTHENTICATION    : MD5
V3 AUTH PASSPHRASE   : 
V3 PRIVACY           : DES
V3 PRIV PASSPHRASE   : 
INFORMATION          : No packets received
STATUS               : Inactive
------

root@172-20-104-107.cisco.com#

Step 4 Use the no device command to delete the device:
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root@172-20-104-107.cisco.com# no device 1
Successfully deleted device 1
root@172-20-104-107.cisco.com#

Note that if the autocreation mode is on, and the device continues to send NDE packets to the NAM, the 
data source (and device entry) will be re-created again automatically as soon as the next NDE packet 
arrives. Therefore, if you wish to delete an existing NetFlow data source, it is usually advisable to first 
turn the NetFlow autocreate feature off, as described earlier.

Testing NetFlow Devices
You can test the SNMP community strings for the devices in the Devices table. To test a device, select 
it from the Devices table, then click Test. The Device System Information Dialog Box displays. 
Table 4-2, Device System Information Dialog Box describes the fields.

If the device is sending NetFlow Version 9 (V9) and the NAM has received the NDE templates, then a 
V9 Templates button appears below the Device System Information window.

Note NetFlow v9 templates do not appear in all NDE packets. When there are no templates, the V9 Templates 
button does not appear.

Table 4-2 Device System Information Dialog Box 

Field Description

Name Name of the device.

Hardware Hardware description of the device.

Device Software Version The current software version running on the device.

System Uptime Total time the device has been running since the last 
reboot.

Location Location of the device.

Contact Contact information for the device.

SNMP read from device SNMP read test result. For the local device only.
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Configuring and Monitoring the Nexus Virtual 
Switch as a Managed Device

A managed device is a switch from which you would like to gather information such as interface 
statistics. For Nexus virtual networks, virtual interfaces statistics will provide insight into your virtual 
network.

This chapter contains the following sections:

 • Setting Up the Managed Device Parameters, page 5-1

 • Monitoring the Managed Device Interfaces, page 5-4

Setting Up the Managed Device Parameters
When you set up a managed device, the NAM retrieves interface information via SNMP from that 
managed device and displays statistics. For NAM on Nexus VSB, you should set these parameters to 
point to a Nexus 1000v switch.

To view the switch information, choose Setup > Managed Device > Device Information. The fields 
are described in Table 5-1, Switch Information.

Table 5-1 Switch Information 

Field Description

SNMP Test information Displays the IP address of the NAM and the switch that the SNMP test 
occurred on.

Name Name of the switch.

Hardware Hardware description of the switch.

Supervisor Software Version Current software version of the Supervisor.

System Uptime Total time the switch has been running.

Location Physical location of the switch.

Contact Contact name of the network administrator for the switch.

SNMP read from switch SNMP read test result. 

SNMP write to switch SNMP write test result. 

Mini-RMON on switch For Cisco IOS devices, displays the status if there are any ports with 
Mini-RMON configured (Available) or not (Unavailable).
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Chapter 5      Configuring and Monitoring the Nexus Virtual Switch as a Managed Device
Setting Up the Managed Device Parameters
This section describes how to set router/managed device parameters. 

Step 1 Choose Setup > Managed Device > Device Information. 

NBAR on switch Displays if NBAR is available on the switch.

VLAN Traffic Statistics on Switch Displays if VLAN data is Available or Unavailable.

Note Catalyst 6500 Series switches require a Supervisor 2 or MSFC2 
card. 

NetFlow Status For Catalyst 6500 Series devices running Cisco IOS, if NetFlow is 
configured on the switch, Remote export to NAM <address> on port 
<number> displays, otherwise the status will display Configuration 
unknown.

Table 5-1 Switch Information (continued)

Field Description
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Chapter 5      Configuring and Monitoring the Nexus Virtual Switch as a Managed Device
Setting Up the Managed Device Parameters
The Router System Information displays as shown in Figure 5-1, Managed Device Information and Set 
Up PageManaged Device Information and Set Up PageManaged Device Information and Set Up Page.

Figure 5-1 Managed Device Information and Set Up Page

Table 5-2, Router/Managed Device System Information. Some of the fields below may not be available 
when using a Nexus 1000V as a managed device.

Table 5-2 Router/Managed Device System Information 

Field Description

Name Name of the router.

Hardware Hardware description of the router.

Managed Device Software 
Version

Current software version of the router.

Managed Device System 
Uptime

Total time the switch has been running.

Location Physical location of the router.

Contact Name of the network administrator for the router.

Managed Device IP address of the router.

SNMP v1/v2c RW Community 
String

Name of the SNMP read-write community string configured on the 
router
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Chapter 5      Configuring and Monitoring the Nexus Virtual Switch as a Managed Device
Monitoring the Managed Device Interfaces
Step 2 Click the Test Connectivity button to perform an SNMP test. Click Close when finished.

Step 3 Click Submit to submit the information and close the window.

Monitoring the Managed Device Interfaces
Monitoring the managed device interfaces provides per-interface statistics directly from the Nexus 
switch. Go to the Analyze > Managed Device > Interfaces (see Figure 5-1). 

Verify String Verify the SNMP .

Enable SNMP V3 Check the check box to enable SNMP Version 3 (starting with NAM 
5.0, you have the ability to manage devices with SNMPv3). If 
SNMPv3 is not enabled, the community string is used. 

Mode: No Auth, No Priv SNMP will be used in a mode with no authentication and no privacy.

Mode: Auth, No Priv SNMP will be used in a mode with authentication, but no privacy.

Mode: Auth and Priv SNMP will be used in a mode with both authentication and privacy.

User Name Enter a username, which will match the username configured on the 
device.

Auth Password Enter the authentication password associated with the username that 
was configured on the device. Verify the password.

Auth Algorithm Choose the authentication standard which is configured on the device 
(MD5 or SHA-1). 

Privacy Password Enter the privacy password, which is configured on the device. Verify 
the password.

Privacy Algorithm Enter the privacy algorithm, which is configured on the device (AES 
or DES).

Table 5-2 Router/Managed Device System Information (continued)

Field Description
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Chapter 5      Configuring and Monitoring the Nexus Virtual Switch as a Managed Device
Monitoring the Managed Device Interfaces
Figure 5-2 Interface Statistics

To change the interval, go to the Interactive Report on the left side of the screen and click the “Filter” 
button.
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Monitoring the Managed Device Interfaces
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C H A P T E R 6

Troubleshooting

This chapter describes some common problems that occur while setting up the Cisco Prime Network 
Analysis Module (NAM) for Nexus 1010. 

 • Resetting the NAM Password, page 6-1

Resetting the NAM Password

Step 1 From the NAM CLI, execute this command:

reboot -helper

Step 2 You will be prompted for Y/N verification that you want to reboot. Click Y, and the NAM will boot into 
the helper image and display the menu.

=====================================================
Cisco Systems, Inc.
Network Analysis Module (NAM) helper utility
Version 5.1 

-----
Main menu
1 - Download application image and write to HDD
2 - Download application image and reformat HDD
3 - Install application image from CD
4 - Display software versions
5 - Reset application image CLI passwords to default
6 - Change file transfer method (currently ftp/http)
7 - Send Ping
n - Configure network
r - Exit and reset Services Engine
h - Exit and shutdown Services Engine Selection [1234567nh]: 

Step 3 At the helper menu, pick 5, “Reset application image CLI passwords to default.”

Step 4 Click r to reset the NAM.

Step 5 After the NAM boots back up, you will need to reset the default password when logging in as root. 
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